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Java Development ToolsJava Development Tools

Quick Overview
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WDSc: Java ToolsWDSc: Java Tools
Java Development Tools (JDT):

Choice of Java level
IBM JRE 1.3 built-in and offered as defaultIBM JRE 1.3 built-in and offered as default

Java projects
Optimized for Java developmentOptimized for Java development
Specialized viewsSpecialized views

Package view and Hierarchy view; Package view and Hierarchy view; 
Outline view: many tools launchable from here!Outline view: many tools launchable from here!

Java EditorJava Editor
Content Assist: Ctrl+Space bar to get list of classes or methodsContent Assist: Ctrl+Space bar to get list of classes or methods
JavaDoc shown as hover helpJavaDoc shown as hover help
F3 to open selected classF3 to open selected class

Refactoring supportRefactoring support
Rename updates all referencesRename updates all references

Incremental compileIncremental compile
When Ctrl+S pressed in editorWhen Ctrl+S pressed in editor
Or on demand via Build Project actionOr on demand via Build Project action
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Java Development ToolsJava Development Tools

Getting Started
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Java PerspectiveJava Perspective
Open the Java perspective

Perspectives
Define which views are shown and their layout in the Define which views are shown and their layout in the 
WorkbenchWorkbench
Targeted towards a specific type of taskTargeted towards a specific type of task

Java, Help, Web, WebFacing, Remote Systems Explorer, XML, ...Java, Help, Web, WebFacing, Remote Systems Explorer, XML, ...

Java perspective contains Java related 
views

PackagesPackages
Shows only the Java projects in your workspaceShows only the Java projects in your workspace
Collapses package directories into a single folder in the tree viewCollapses package directories into a single folder in the tree view

Outline (standard workbench view)Outline (standard workbench view)
High level view overview of the structure of your Java classHigh level view overview of the structure of your Java class

HierarchyHierarchy
Inheritance hierarchy of the Java classInheritance hierarchy of the Java class

Tasks (standard workbench view)Tasks (standard workbench view)
Shows compile errors and warningsShows compile errors and warnings
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Java PerspectiveJava Perspective

Shortcuts to related 
perspectives

All available perspectives
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Java PerspectiveJava Perspective

Open 
perspectives

Java editor

Task view 
(error list)

Outline 
viewPackages 

views

Java specific wizards
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ProjectsProjects
Projects

Highest level of organization for resources
Contains files and folders
Projects have

A typeA type
Java, iSeries, Server, Web, Simple (generic)Java, iSeries, Server, Web, Simple (generic)

PropertiesProperties
Associated buildersAssociated builders

Builders know how to convert source artifacts (files) to executablesBuilders know how to convert source artifacts (files) to executables

Web project
Java project

Server project
- WebSphere
- Tomcat

iSeries project
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New Java Project WizardNew Java Project Wizard
Enter a name for 
your project.

The workspace is where your 
files (.java, .class, .properties, ...)
are stored on disk.  

Recommendation:  Use the default! 
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Creating a Java PackageCreating a Java Package

Your Java Project!

Note:  Right click to get popup menu
- or select shortcut icon
- or select File -> Java Package

Shortcut to Java 
package wizard

Enter a name for your java 
package.  Typically this 
starts with the reverse of 
your companies TCP/IP 
domain name.  

For example:  com.ibm...
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Creating a Java ClassCreating a Java Class
Folder and 
package names
are prefilled
from Workbench 
selection

Enter a name
for the class 

Select any 
access modifiers
for the class 

Enter the name 
of a superclass 
or click Browse 
to select one 
from your 
workspace Enter any 

interfaces you 
want your class 
to implement

The wizard can generate 
some common methods 
methods if you want them

Create this
class as an
inner class 
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Good So Far ...Good So Far ...
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Java Development ToolsJava Development Tools

The Java Editor
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Tip:  Double click on
title bar to make editors
and views full screen

Code Assist - Java CodeCode Assist - Java Code

Ctrl + Space brings up 
the code assist with a 
list of all possible 
matches based on 
what is already typed
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Code Assist - JavaDocCode Assist - JavaDoc

Code assist is also 
available in JavaDoc 
comments for:

HTML
<b> ... </b>
<i> ... </i>
...

JavaDoc keywords
@param
@return
...
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JavaDoc ReferenceJavaDoc Reference
> javadoc JDBCSample.java
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Managing Your ImportsManaging Your Imports
First setup preferences

Window -> Preferences
Specify order imports should be listed

For example:  java, then javax, then comFor example:  java, then javax, then com
Add your own!!!Add your own!!!

Specify how many qualified imports to use 
before importing everything 

See next slide
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Managing Your ImportsManaging Your Imports
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Managing Your ImportsManaging Your Imports

Error in code because
the class AS400 has
not been imported yet.

To import a class 
simply highlight the
class name and select
"Add Import" from the
popup menu.

Tip:  Double clicking on
a class name or
variable will highlight
it.
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Formatting Your CodeFormatting Your Code

1. First set your  
preferences in the 
preferences dialog

   Then ...

The Java Editor can 
automatically format 
your code however 
you would like

Maximum line length
{ } preferences

New lines
Same line as code

...
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Formatting Your CodeFormatting Your Code

2. Right click in 
the editor and 
select "Format"

VOILA!
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Other Misc. FunctionsOther Misc. Functions

Editor also lets 
you manipulate 
blocks of code at 
a time

Shift right
Shift left
Comment
Uncomment

Select the block of 
code, right click 
and select the 
required function 
from the popup 
menu
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Java Development ToolsJava Development Tools

Nominees For Best Supporting 
View
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Packages ViewPackages View
Navigator View

The Eclipse tree view for managing all 
resources in the workspace
Shows Java classes in their package 
directories 

This takes a lot of space in the tree viewThis takes a lot of space in the tree view
For example:  com/ibm/java/samplesFor example:  com/ibm/java/samples

Packages View
Provides central place to manage your 
Java resources
Shows only Java related projects

This includes Web projects!This includes Web projects!

Packages shown as single entry in tree view
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Packages ViewPackages View

Packages

Projects

Source files

Libraries referenced by 
this project (more on this
later when we look at the
project build properties)

Tip:  These can also be
expanded!
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Outline ViewOutline View
Java Outline View

Works in concert w/ Java Editor
Shows imports, fields, methods

Can subset what is shownCan subset what is shown
Can sort by nameCan sort by name

Can show only selected member 
in editor

Can auto-add imports 
Can auto-gen getter 
and setter methods
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WDSc: Java ToolsWDSc: Java Tools
Java Outline View

Works in concert w/ Java 
Editor
Shows imports, fields, methods

Can subset what is shownCan subset what is shown
Can sort by nameCan sort by name

Can restrict to selected 
member only in editor

Can auto-add imports 
Can auto-gen getter 
and setter methods
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Hierarchy ViewHierarchy View
Hierarchy View

Provides 3 different ways to view a class in 
its type hierarchy

Show only supertype hierarchyShow only supertype hierarchy
This includes superclasses and interfaces!This includes superclasses and interfaces!

Show only subtype hierarchyShow only subtype hierarchy
Show class in its full hierarchy treeShow class in its full hierarchy tree

Includes both superclasses and subclassesIncludes both superclasses and subclasses

Ability to perform actions
Create copies of methods from superclasses in current Create copies of methods from superclasses in current 
classclass

Right click on method and select "Create in Right click on method and select "Create in classnameclassname""
Refactoring Refactoring 

Rename methods and fieldsRename methods and fields
Rename parameters for methodsRename parameters for methods
Generate getter and setter methods for fieldsGenerate getter and setter methods for fields
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Hierarchy ViewHierarchy View

Type hierarchy

Supertype hierarchy
Subtype hierarchy

Currently showing all
methods in 
AbstractList class

1. Shows selected members 
in hierarchy at all locations 
where they are declared.

Lets you see where members are 
declared and overridden.

2.  Show / hide inherited 
members

3.  Show / hide fields

4.  Show / hide static 
members

5.  Show / hide nonpublic 
members

1 2 3 4 5

To open a class in 
the hierarchy view 
highlight the class 
name in any source 
file or view and 
press F4.
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Tasks ViewTasks View
Tasks view

Shows:
1.1. All compile errors, warnings and information associated All compile errors, warnings and information associated 

with resources in the workspacewith resources in the workspace
2.2. Tasks defined by the userTasks defined by the user

Tasks can be set on a specific line in a resource or globallyTasks can be set on a specific line in a resource or globally
"Don't forget to add error checking here!""Don't forget to add error checking here!"

Not Java specific!
Shows errors and tasks for Java, HTML, XML, RPG, ...Shows errors and tasks for Java, HTML, XML, RPG, ...

Provides ability to filter by
Type of problemType of problem

Java problem, XML Schema problem, broken links in HTML or JSPJava problem, XML Schema problem, broken links in HTML or JSP
Severity of the problem or priority of the taskSeverity of the problem or priority of the task
Problem / task descriptionProblem / task description
Based on what is selected in the navigator / packages viewBased on what is selected in the navigator / packages view
Status of the taskStatus of the task
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Tasks ViewTasks View

Global task
no resources is specified

Warning

Error

Completed task

Tip:  Double click on the task / problem to 
open the resource in the editor at the correct 
line!

Resource where the 
problem / task occurs

Project and folder(s) 
where the resource
is located

Filter
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Java Development ToolsJava Development Tools

Compiling
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Compiling Your Java ClassCompiling Your Java Class
Done!

Everytime you save your file it is 
automatically compiled!
Manually compiling

Right click on the project, package or class and select Right click on the project, package or class and select 
either:either:

Build ProjectBuild Project
Incremental buildIncremental build
Builds only resources that have changed Builds only resources that have changed 

   since the last build   since the last build
Rebuild ProjectRebuild Project

Full buildFull build
Discards previous build state and rebuilds Discards previous build state and rebuilds 

   everything   everything
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Java Development ToolsJava Development Tools

Running
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Running Your Java ClassRunning Your Java Class
How you run your class depends on 
what it is

Standalone Java application
Class implements method:Class implements method:

public static void main(String[] args)public static void main(String[] args)
Run locally usingRun locally using

JDK shipped with the workbenchJDK shipped with the workbench
Any locally installed JDKAny locally installed JDK

Run remotely using iSeries extensionsRun remotely using iSeries extensions

Servlet
Class extends javax.servlet.http.HttpServletClass extends javax.servlet.http.HttpServlet
Servlet can be run inServlet can be run in

Local WebSphere Test EnvironmentLocal WebSphere Test Environment
Local Tomcat Test EnvironmentLocal Tomcat Test Environment
Local Tomcat Application ServerLocal Tomcat Application Server
Remote WebSphere Application ServerRemote WebSphere Application Server
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Standalone ApplicationsStandalone Applications
1.  Select java file in packages view 2.  Select Run -> Java Application 

Debug perspective opens and
output shown in Console view 

Tip:  Turn off debug preference to 
"Show debug perspective when 
program launched in run mode".
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Java Development ToolsJava Development Tools

Java Debug
Not that you will need it!
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DebugDebug

Shortcut:  Run and debug 
menus remember the last few 
applications that were run. 

You can select this instead of 
selecting the class and then 
choosing Debug -> Java 
Application. 

Opens debug perspective ... 

Tip:  Set breakpoints in 
your source code 
before launching the 
debugger.

You can set 
breakpoints in the Java 
editor by double 
clicking in the left hand 
margin of the editor.
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Debug PerspectiveDebug Perspective

Details 
F03SP17-JavaTools.prz 42



iSeries AD, IBM Toronto iSeries AD, IBM Toronto 

Debug PerspectiveDebug Perspective

Debug view shows:
All running applications

Threads
Execution stack for 
suspended threads

Shortcut buttons for:
Resume
Suspend
Stop
Step into / over / return

Console View

Breakpoint
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Breakpoints View
Manage breakpoints in the workspace
Add Java exception breakpoints

Stop when a NullPointerException is thrown
This can be very handle in locating 
problems!

Inspector view
Detailed view for inspecting variables

Variables View
Shows all variables that are visible in the 
current stack frame

Display View
Displays result of executing an expression 
in context of current stack frame
Highlight expression in editor and select 
"Display" from the popup menu

Debug PerspectiveDebug Perspective
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Java Development ToolsJava Development Tools

Searching .... 
Now where did that go?
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SearchingSearching
Two main ways to search

Global workspace searching
Search the entire workspaceSearch the entire workspace

Context sensitive searching
Scope to workspace or class hierarchyScope to workspace or class hierarchy
Packages / Classes / Interfaces / Variables / MembersPackages / Classes / Interfaces / Variables / Members

Find all places where referencedFind all places where referenced
Find all places where they are declaredFind all places where they are declared

In workspace, orIn workspace, or
In class hierarchyIn class hierarchy

InterfacesInterfaces
Find all implementorsFind all implementors

Results are shown in the "Search" view
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Java Aware SearchJava Aware Search

Simple text searching

Java "aware" searching

Find all types, 
methods, 
packages, 
constructors or 
fields that 
match the 
search 
expression.   

Search only for 
declarations or 
references to 
the specified 
type, method, 
package, ....
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Context SearchingContext Searching

Tip:  Anywhere you see a 
package / method / variable 
name you can right click on the 
name and select "Search -> ..." 
from the popup menu.   

This is equivalent to selecting 
the search dialog entering the 
name and setting the "Search 
For" and "Limit To" fields.
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Java Build PathJava Build Path
Java Build Path

Each Java project has a build path that 
defines

How resources are builtHow resources are built
Where output (.class files) are placed after a buildWhere output (.class files) are placed after a build

Where external resources are locatedWhere external resources are located
Source from other projects in the workspaceSource from other projects in the workspace
JAR files from other projectsJAR files from other projects
External JAR filesExternal JAR files

Similar to setting the CLASSPATH when 
running applications outside the 
workbench
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Java Build Path - SourceJava Build Path - Source

Source
Specify whether project uses source folders or not
Source folders are recommended for large projects

Provides an additional level of grouping between the 
project and Java packages
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Java Build Path - ProjectsJava Build Path - Projects

Projects
Select all projects in the workspace that are required by 
this project

i.e. This project uses classes in the other project

F03SP17-JavaTools.prz 51



iSeries AD, IBM Toronto iSeries AD, IBM Toronto 

Java Build Path - LibrariesJava Build Path - Libraries

Libraries
These are NOT OS/400 libraries!
Specify all JAR files required by your Java project

i.e. IBM Toolbox for Java
d:\WDSC\WSSD\plugins\com.ibm.etools.iseries.toolbox\runtime\jt400.jar

   
Add JAR file 
from another 
project

Add JAR file 
from the local 
filesystem
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Java Build Path - OrderJava Build Path - Order

Order
Specify the order the projects and libraries are included in the build path
This is important if the different versions of the same class exists in to 
different entries
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Java Development ToolsJava Development Tools

iSeries Additions
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Java Tools for iSeriesJava Tools for iSeries

iSeries extensions for Java
Overview / Nutshell:

Import and export from/to remote systemImport and export from/to remote system
Remote Compile and RunRemote Compile and Run
Remote DebugRemote Debug
Program Call wizardProgram Call wizard
Toolbox for Java built-inToolbox for Java built-in

As an Eclipse Java project (i.e.: easy to add to classpath of your project!)As an Eclipse Java project (i.e.: easy to add to classpath of your project!)
Integrated helpIntegrated help
Runnable samplesRunnable samples

Supplied Java-beansSupplied Java-beans
Swing GUI beans (dspf-like functionality)Swing GUI beans (dspf-like functionality)
DFU beans (database access)DFU beans (database access)
Object list beans (library, object, member, field, record lists)Object list beans (library, object, member, field, record lists)
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Java Tools for iSeriesJava Tools for iSeries
iSeries extensions for Java

Import and export
Builds on base support for import/exporting files/jars/zipsBuilds on base support for import/exporting files/jars/zips
Add support to import/export files from remote systemAdd support to import/export files from remote system

Import any files from any remote system (iSeries/Unix/Linux/Windows)Import any files from any remote system (iSeries/Unix/Linux/Windows)
Eg: IFS on iSeries; Linux LPAR on iSeriesEg: IFS on iSeries; Linux LPAR on iSeries

Export files from any project to any remote systemExport files from any project to any remote system
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Java Tools for iSeriesJava Tools for iSeries

Browse for Browse for 
IFS target IFS target 

folderfolder

Remembers Remembers 
previous previous 

export foldersexport folders

Select files to Select files to 
exportexport
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Java Tools for iSeriesJava Tools for iSeries
Remote Compile and Run

After exporting Java files to iSeries, you:After exporting Java files to iSeries, you:
Transform them there using CRTJVAPGMTransform them there using CRTJVAPGM
Run them there, see results via Console Run them there, see results via Console 
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Java Tools for iSeriesJava Tools for iSeries
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Java Tools for iSeriesJava Tools for iSeries
Remote Debug

Launches debugger for iSeries JavaLaunches debugger for iSeries Java
Same debugger as RPG, CBL, CL, C, C++ Same debugger as RPG, CBL, CL, C, C++ 
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Java Tools for iSeriesJava Tools for iSeries

Program Call Wizard
Given signature of *PGM or *SRVPGM proc:

Generate Java Bean to call itGenerate Java Bean to call it
Steps:

1. Select Java/Web/WebFacing project1. Select Java/Web/WebFacing project
2. Select package2. Select package
3. Use File->New->Other...   3. Use File->New->Other...   

...iSeries Java Program Call Bean...iSeries Java Program Call Bean
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Java Tools for iSeriesJava Tools for iSeries

Type info, press Type info, press 
OKOK
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Enter Parameter InfoEnter Parameter Info

Define and name Define and name 
structurestructure

Define Define 
parametersparameters

> 0 for > 0 for 
arrayarray

Be sure to press OK for Be sure to press OK for 
each parameter / each parameter / 

structurestructure

Builds up Builds up 
parameter parameter 

listlist
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Final PageFinal Page

Where to generate Java classWhere to generate Java class

Where to generate PCML fileWhere to generate PCML file

Select Select Web ServicesWeb Services to generate Java code optimized for  to generate Java code optimized for 
use in the Web Services wizarduse in the Web Services wizard

Summary of files Summary of files 
that will be that will be 
generatedgenerated

Runtime files you Runtime files you 
will need to deploy will need to deploy 

with your codewith your code

To change parameters later:To change parameters later:
Return to wizardReturn to wizard
Use Import PCML... Use Import PCML... 
buttonbutton
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Generated Java BeanGenerated Java Bean

package customer.demo;
public class TestMyProgram 
{
    public static void main(String[] args)
    {
        MyProgram test = new MyProgram();
        test.setConnectionData("MYSYSTEM", "MYUSERID", 

"MYPASSWORD");
        test.setLibraryList(new String[] {"PHILDEMO"});
        test.invoke();
        int nbrResults = test.getNbrCodes().intValue();
        System.out.println("Nbr Codes: " + nbrResults);
        for (int idx=0; idx<nbrResults; idx++)
        {
        System.out.println(" code " + idx + ": " +
                             test.getDlvCodes(idx).trim());
        }
    }

Wizard Wizard 
adds adds 

required required 
files to files to 
project project 

classpathclasspath

Example Example 
using using 

gen'd beangen'd bean

setConnectionData(...)
to identify signon info

setLibraryList(...)
to set runtime library list

setXXX(...) 
to set input parameters

invoke() 
to run program

getXXX(...) 
to get output parameters
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Java Tools for iSeriesJava Tools for iSeries

GUI Beans for iSeries 
Java Beans supplied for DDS-like field 
error-checking and formatting:

JFormattedTextField (smart entry field)JFormattedTextField (smart entry field)
Error checking based on data type, length, decimalsError checking based on data type, length, decimals
DDS-like validity checking: range or comparisonDDS-like validity checking: range or comparison
Editcode or editword formatting and masking(!)Editcode or editword formatting and masking(!)
Auto-advanceAuto-advance

JFormattedLabel (smart label constant)JFormattedLabel (smart label constant)
Editcode or editword formattingEditcode or editword formatting

JFormattedComboBox (smart dropdown)JFormattedComboBox (smart dropdown)
Combo of JFormattedTextField and JFormattedLabelsCombo of JFormattedTextField and JFormattedLabels

JFormattedTable (smart multi-column listJFormattedTable (smart multi-column list
A "subfile" or multi-column list boxA "subfile" or multi-column list box
Each cell is a JFormattedTextField or JFormattedLabel or Each cell is a JFormattedTextField or JFormattedLabel or 
JFormattedComboBoxJFormattedComboBox
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Java Tools for iSeriesJava Tools for iSeries

GUI Beans Examples
File->New->Other->Examples->iSeries 

JFormattedTableJFormattedTable

JFormattedText JFormattedText 
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Java Tools for iSeriesJava Tools for iSeries

DFU Beans for iSeries (non GUI)
Java Beans supplied for querying data 
from DB2/400, using direct record access 
(versus SQL):

RecordIOManager:RecordIOManager:
Query, add, update or delete records in a databaseQuery, add, update or delete records in a database
Vastly simplifies task of writing database access code using Toolbox Vastly simplifies task of writing database access code using Toolbox 
for Java classesfor Java classes

ListManager:ListManager:
Maps list of records from RecordIOManager to a Swing GUI listMaps list of records from RecordIOManager to a Swing GUI list
Makes it easy to populate GUI list with DB2/400 dataMakes it easy to populate GUI list with DB2/400 data

FormManagerFormManager
Maps details of a single row from RecordIOManager to a single GUI Maps details of a single row from RecordIOManager to a single GUI 
dialog pagedialog page
Makes it easy to populate GUI form with DB2/400 dataMakes it easy to populate GUI form with DB2/400 data
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Java Tools for iSeriesJava Tools for iSeries
DFU Beans Examples

File->New->Other->Examples->iSeries
ListManagerListManager

FormManager FormManager 

F03SP17-JavaTools.prz 69



iSeries AD, IBM Toronto iSeries AD, IBM Toronto 

Java Tools for iSeriesJava Tools for iSeries

List Beans for iSeries (non-GUI)
For querying lists of libraries, objects, 
members, records or fields

AS400ListLibrariesAS400ListLibraries
List libraries given simple or generic or special nameList libraries given simple or generic or special name

AS400ListObjectsAS400ListObjects
List objects given simple or generic library and object nameList objects given simple or generic library and object name
Can also subset by type and attr (one or multi, simple or generic)Can also subset by type and attr (one or multi, simple or generic)

AS400ListMembersAS400ListMembers
List members given simple or generic library, file, member nameList members given simple or generic library, file, member name
Can also subset by member type (one or multi, simple or generic)Can also subset by member type (one or multi, simple or generic)

AS400ListRecordsAS400ListRecords
List records given simple or generic library, file, record nameList records given simple or generic library, file, record name

AS400ListFieldsAS400ListFields
List fields given simple or generic library, file, record, field nameList fields given simple or generic library, file, record, field name

Four levels of detail possible per object
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Java Development ToolsJava Development Tools

Summary
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Java Tools Not ThereJava Tools Not There
Not all VAJava function is 
available yet:

Visual Composition EditorVisual Composition Editor
DataBase BeansDataBase Beans
Actually, there are replacements! Just no visual metaphorActually, there are replacements! Just no visual metaphor
See com.ibm.db.beans: DBSelect, DBProcedureCall, DBModifySee com.ibm.db.beans: DBSelect, DBProcedureCall, DBModify
There is also a Database access wizard in Web ToolsThere is also a Database access wizard in Web Tools
SQLJ supportSQLJ support
Stored Procedure BuilderStored Procedure Builder
Live editing while debuggingLive editing while debugging

For VAJava migration...
www.ibm.com/software/wsddwww.ibm.com/software/wsdd
"VisualAge for Java coexistence with WebSphere Studio Application Developer""VisualAge for Java coexistence with WebSphere Studio Application Developer"
http://www7b.boulder.ibm.com/wsdd/library/techarticles/0110_searle/searle.htmlhttp://www7b.boulder.ibm.com/wsdd/library/techarticles/0110_searle/searle.html

F03SP17-JavaTools.prz 72



iSeries AD, IBM Toronto iSeries AD, IBM Toronto 

SummarySummary
Java Development Tooling included in WDSC

Part of WebSphere Studio Site Developer Advanced
Java Perspective provides optimized view for Java 
development

Java Editor + Java Views = Easier Development
Integrated Compile / Run / Debug
iSeries Additions for using Java with iSeries
Lots more ...

Team developmentTeam development
Integrated, online help systemIntegrated, online help system
Extendable platformExtendable platform

You can add your own toolsYou can add your own tools
Integrated Java, Web, XML, iSeries developmentIntegrated Java, Web, XML, iSeries development

Enjoy!
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ResourcesResources
Eclipse.org

Website for the open source Workbench

WDSC
ibm.com/software/ad/wds400/

WebSphere Developer Domain
ibm.com/websphere/developer

IBM Developer Domain
ibm.com/developer

Java
java.sun.com
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8 IBM Corporation 1994-2002.  All rights reserved.
References in this document to IBM products or services do not imply that IBM intends to make them available in every country.
The following terms are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both:

Lotus, Freelance Graphics, and Word Pro are registered trademarks of Lotus Development Corporation and/or IBM Corporation.
Domino is a trademark of Lotus Development Corporation and/or IBM Corporation.

C-bus is a trademark of Corollary, Inc. in the United States, other countries, or both. 
Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both. 
Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both. 
ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel Corporation in the United States, other countries, or both. 
UNIX is a registered trademark of The Open Group in the United States and other countries.
SET and the SET Logo are trademarks owned by SET Secure Electronic Transaction LLC. 
Other company, product and service names may be trademarks or service marks of others.

Information is provided "AS IS" without warranty of any kind.

All customer examples described are presented as illustrations of how those customers have used IBM products and the results they may have achieved.  Actual 
environmental costs and performance characteristics may vary by customer.

Information in this presentation concerning non-IBM products was obtained from a supplier of these products, published announcement material, or other publicly 
available sources and does not constitute an endorsement of such products by IBM.  Sources for non-IBM list prices and performance numbers are taken from publicly 
available information, including vendor announcements and vendor worldwide homepages.  IBM has not tested these products and cannot confirm the accuracy of 
performance, capability, or any other claims related to non-IBM products.  Questions on the capability of non-IBM products should be addressed to the supplier of those 
products.

All statements regarding IBM future direction and intent are subject to change or withdrawal without notice, and represent goals and objectives only.  Contact your local 
IBM office or IBM authorized reseller for the full text of the specific Statement of Direction.

Some information in this presentation addresses anticipated future capabilities.  Such information is not intended as a definitive statement of a commitment to specific 
levels of performance, function or delivery schedules with respect to any future products.  Such commitments are only made in IBM product announcements.  The 
information is presented here to communicate IBM's current investment and development activities as a good faith effort to help with our customers' future planning. 

Performance is based on measurements and projections using standard IBM benchmarks in a controlled environment.  The actual throughput or performance that any 
user will experience will vary depending upon considerations such as the amount of multiprogramming in the user's job stream, the I/O configuration, the storage 
configuration, and the workload processed.  Therefore, no assurance can be given that an individual user will achieve throughput or performance improvements 
equivalent to the ratios stated here.

Photographs shown are of engineering prototypes.  Changes may be incorporated in production models.
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Trademarks & DisclaimersTrademarks & Disclaimers
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